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Thank you for purchasing the Daqstation DX364 (DX). This manual 
covers the basic functions, installation, and connection procedure 
of the DX. It also describes the operating procedures, functions, 
and specifications that are different from the DX1000. To ensure 
correct use, please read this manual thoroughly before beginning 
operation. The DX comes with the following manuals.

 Paper Manual
Manual Title Manual No.
DX364 User’s Manual IM 04L70B01-01E

This manual. Read this manual before reading the 
DX1000/DX1000N/DX2000 electronic manuals. 

 DAQSTANDARD
Download the DAQSTANDARD (Application software) from the 
following URL.
URL: https://www.yokogawa.com/ns/dxadv/download/

 Electroric Manuals
You can download these manuals from the following web page.
https://y-link.yokogawa.com/YL000/
Manual Title Manual No.
DX1000/DX1000N User’s manual IM 04L41B01-01E

Explains how to use the useful functions of the DX1000/
DX1000N. The display orientation and the operating 
procedures are different from the DX364. Some function 
cannot be used on the DX364. For the communication 
functions, see IM 04L41B01-17E.

DX1000/DX1000N Operation Guide IM 04L41B01-02E
Explains the basic operations. The operating procedures 
differ from the DX364.

DX1000/DX1000N/DX2000 
Communication Interface User’s Manual

IM 04L41B01-17E

Describes how to use the communication functions using 
the Ethernet interface. Some functions are different on the 
DX364.

DAQSTANDARD Viewer User’s Manual IM 04L41B01-63EN
DAQSTANDARD Hardware Configurator 
User’s Manual

IM 04L41B01-64EN

DAQSTANDARD DX-P Hardware 
Configurator User’s Manual

IM 04L41B01-65EN

Installing DAQSTANDARD IM 04L41B01-66EN

 DAQSTANDARD Manuals
Manual Title Manual No.
DAQSTANDARD Viewer User’s Manual IM 04L41B01-63EN
DAQSTANDARD Hardware Configurator 
User’s Manual

IM 04L41B01-64EN

DAQSTANDARD DX-P Hardware 
Configurator User’s Manual

IM 04L41B01-65EN

Installing DAQSTANDARD IM 04L41B01-66EN
* The last one characters of the manual number and general 

specification number indicate the language in which the manual 
is written.

 About the DX364 User’s Manual
The DX364 operation differs from the DX1000. Please familiarize 
yourself with the setup operations explained in this manual before 
reading the electronic manuals.

Notes
• The contents of this manual are subject to change without prior 

notice as a result of continuing improvements to the instrument’s 
performance and functions.

• Every effort has been made in the preparation of this manual to 
ensure the accuracy of its contents. However, should you have 
any questions or find any errors, please contact your nearest 
YOKOGAWA dealer.

• Copying or reproducing all or any part of the contents of this 
manual without YOKOGAWA’s permission is strictly prohibited.

• This manual is part of this product. Keep this manual on safe 
place for future reference.

• The TCP/IP software of this product and the document 
concerning the TCP/IP software have been developed/created 
by YOKOGAWA based on the BSD Networking Software, 
Release 1 that has been licensed from the Regents of the 
University of California.

About the Usage of Open Source Software
MD5
The following products uses MD5 source code. 
In accordance with the MD5 license agreement, the copyright 
notice, redistribution conditions, and license are listed below.

DX364

• RSA Data Security’s MD5 License

RSA Data Security, Inc., MD5 message-digest algorithm
Copyright (C) 1991-2, RSA Data Security, Inc. Created 1991. All 
rights reserved.

License to copy and use this software is granted provided that it 
is identified as the "RSA Data Security, Inc. MD5 Message-Digest 
Algorithm" in all material mentioning or referencing this software or 
this function.
License is also granted to make and use derivative works provided 
that such works are identified as "derived from the RSA Data 
Security, Inc. MD5 Message-Digest Algorithm" in all material 
mentioning or referencing the derived work.
RSA Data Security, Inc. makes no representations concerning 
either the merchantability of this software or the suitability of this 
software for any particular purpose. It is provided "as is" without 
express or implied warranty of any kind.
These notices must be retained in any copies of any part of this 
documentation and/or software.

Authorised Representative in the EEA and the 
Importer into the EU/EEA Market
The Authorised Representative for this product in the EEA and the 
importer for this product into the EU/EEA market via Yokogawa sale 
channel is:
    Yokogawa Europe B.V.
    Euroweg 2, 3825 HD Amersfoort,The Netherlands

Importer for This Product into the Great Britain 
Market
In relation to UKCA marking, the importer for this product into the 
Great Britain market via the YOKOGAWA sales channel is :
    Yokogawa United Kingdom Limited
    Stuart Road Manor Park Runcorn, WA7 1TR, United Kingdom

QR Code
The product has a QR Code pasted for efficient plant maintenance 
work and asset information management.
It enables confirming the specifications of purchased products and 
user’s manuals.
For more details, please refer to the following URL.
https://www.yokogawa.com/qr-code

QR Code is a registered trademark of DENSO WAVE 
INCORPORATED.

10th Edition: August 2023 (YK)
All Rights Reserved, Copyright © 2007, Yokogawa Electric Corporation
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Trademarks
• All the brands or names of Yokogawa Electric’s products used 

in this manual are either trademarks or registered trademarks of 
Yokogawa Electric Corporation.

• Microsoft and Windows are either registered trademarks or 
trademarks of Microsoft Corporation in the United States and/or 
other countries.

• Adobe, Acrobat, and PostScript are trademarks of Adobe 
Systems Incorporated (Adobe Systems).

• CompactFlash and CF are trademarks of SanDisk Corporation.
• For purposes of this manual, the ™ and ® symbols do not 

accompany their respective trademark names or registered 
trademark names.

• Company and product names that appear in this manual are 
trademarks or registered trademarks of their respective holders.

Revisions
1st Edition:  February 2007 2nd Edition:  March 2010
3rd Edition:  December 2014 4th Edition:  March 2016
5th Edition:  June 2018 6th Edition: May 2019
7th Edition:  June 2020 8th Edition: April 2021
9th Edition: October 2022 10th Edition: August 2023

DX364 Versions and Functions
Edition Product Addition and Change
1 Version 2.01 -
2 Version 2.06 ･ Color Band Display have been 

changed or added.
･ Larger Scale Font
･ Changes to the Scales on the Bar 

Graph Display
3 Release 

number 
2 (Style 
number H: 2)
Version 2.06

･ LCD is changed to the high-
brightness product.

4 Same above ･ Compliant with Safety Standards 
(IEC/EN/UL/CSA 61010-1 3rd 
edition)

5 Same above ･ Additions of “Waste Electrical and 
Electronic Equipment (WEEE), 
Directive”

6 Same above Delete the CF card adapter.
Changed the battery assembly part 
number.

7 Release 
number 
2 (Style 
number H: 3)
Version 2.1x

Changed the style (H).

8 Same above Compliant with CE RoHS 
directive (10-Substances)

9 Same above Correspodence to UKCA

Safety Precautions
• The DX conforms to IEC safety class I (provided with terminal for 

protective grounding), Overvoltage Category II or I*1, Pollution 
Degree 2, Measurement Category II (CAT II)*2, and EN61326-
1 (EMC standard) class A (use in a commercial, industrial, or 
business environment).

 The influence rate (judgment condition A) in the immunity test 
environment is within ±10 % of the range or ±10 mV (50V range 
only, ±20 % of the range).

*1 Overvoltage Category II: Applide to standard power supply (100-
240 VAC), I: Applide to /P1 option (24 VDC/AC)

*2 Measurement Category II (CAT II)
 Applies to measuring circuits connected to low voltage 

installation, and electrical instruments supplied with power from 
fixed equipment such as electric switchboards.

• The general safety precautions described here must be 
observed during all phases of operation. If the DX is used in a 
manner not described in this manual, the protection provided 
by the DX may be impaired. Yokogawa Electric Corporation 
assumes no liability for the customer’s failure to comply with 
these requirements.

• The DX is designed for indoor use.

• About This Manual
• Please pass this manual to the end user. We also ask you to 

store this manual in a safe place.
• Read this manual thoroughly and have a clear understanding of 

the product before operation.
• This manual explains the functions of the product. It does not 

guarantee that the product will suit a particular purpose of the 
user.

• Precautions Related to the Protection, Safety, and Alteration of 
the Product
The following safety symbols are used on the product and in this 
manual.

“Handle with care.” To avoid injury and damage to the
instrument, the operator must refer to the explanation
in the manual.
Protective ground terminal

Alternating current

Direct current

• For the protection and safe use of the product and the system 
in which this product is incorporated, be sure to follow the 
instructions and precautions on safety that are stated in this 
manual whenever you handle the product. Take special note 
that if you handle the product in a manner that violates these 
instructions, the protection functionality of the product may be 
damaged or impaired. In such cases, YOKOGAWA does not 
guarantee the quality, performance, function, and safety of 
product.

• When installing protection and/or safety circuits such as lightning 
protection devices and equipment for the product and control 
system or designing or installing separate protection and/or 
safety circuits for fool-proof design and fail-safe design of the 
processes and lines that use the product and the control system, 
the user should implement these using additional devices and 
equipment.

• If you are replacing parts or consumable items of the product, 
make sure to use parts specified by YOKOGAWA.
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• This product is not designed or manufactured to be used in 
critical applications that directly affect or threaten human lives. 
Such applications include nuclear power equipment, devices 
using radioactivity, railway facilities, aviation equipment, air 
navigation facilities, aviation facilities, and medical equipment. 
If so used, it is the user’s responsibility to include in the system 
additional equipment and devices that ensure personnel safety.

• Do not modify this product.

 WARNING

 • Use the Correct Power Supply
 Ensure that the source voltage matches the voltage of the power 

supply before turning ON the power.
 • Connect the Protective Grounding Terminal

 Make sure to connect the protective grounding to prevent 
electric shock before turning ON the power.

 • Do Not Impair the Protective Grounding
 Never cut off the internal or external protective grounding wire or 

disconnect the wiring of the protective grounding terminal. Doing 
so invalidates the protective functions of the instrument and 
poses a potential shock hazard.

 • Do Not Operate with Defective Protective Grounding
 Do not operate the instrument if the protective grounding might 

be defective. Also, make sure to check them before operation.
 • Do Not Operate in an Explosive Atmosphere

 Do not operate the instrument in the presence of flammable 
liquids or vapors. Operation in such an environment constitutes 
a safety hazard.

 Prolonged use in a highly dense corrosive gas (H2S, SOx, etc.) 
will cause a malfunction.

 • Do Not Remove Covers
 The cover should be removed by YOKOGAWA’s qualified 

personnel only. Opening the cover is dangerous, because some 
areas inside the instrument have high voltages.

 • Ground the Instrument before Making External Connections
 Connect the protective grounding before connecting to the item 

under measurement or control unit.
 • Damage to the Protection

 Operating the instrument in a manner not described in this 
manual may damage the instrument’s protection.

 • Pull Out the Inner Instrument Correctly
 Pull out the inner instrument correctly according the instructions 

given in “Pulling Out the Inner Instrument” in this manual.

• Exemption from Responsibility
• YOKOGAWA makes no warranties regarding the product except 

those stated in the WARRANTY that is provided separately.
• YOKOGAWA assumes no liability to any party for any loss 

or damage, direct or indirect, caused by the user or any 
unpredictable defect of the product.

• Handling Precautions of the Software
• YOKOGAWA makes no warranties regarding the software 

accompanying this product except those stated in the 
WARRANTY that is provided separately.

• Use the software on a single PC.
• You must purchase another copy of the software, if you are to 

use the software on another PC.
• Copying the software for any purposes other than backup is 

strictly prohibited.
• Please store the original media containing the software in a safe 

place.
• Reverse engineering, such as decompiling of the software, is 

strictly prohibited.
• No portion of the software supplied by YOKOGAWA may be 

transferred, exchanged, or sublet or leased for use by any third 
party without prior permission by YOKOGAWA.

Handling Precautions of the DX
• Use care when cleaning the DX, especially any plastic parts. 

When cleaning, wipe using a dry soft cloth. Do not use chemicals 
such as benzene or thinner, since these may cause discoloring 
and deformation.

• Keep electrically charged objects away from the signal terminals. 
If you do, the DX may malfunction.

• Do not apply volatile chemicals to the display, panel keys, etc. 
Do not allow rubber and vinyl products to remain in contact 
with the DX for long periods of time. If you do, the DX may 
malfunction.

• If there are any symptoms of trouble such as strange odors or 
smoke coming from the DX, immediately turn OFF the power 
switch and the power supply source. Then, contact your nearest 
YOKOGAWA dealer.

Handling Precautions of the External Storage 
Medium (CF Card)

• Use caution in the handling of the external storage medium as it 
is a delicate product.

• Write operation to storage media may fail under high-
temperature or low-temperature environments. If you are using 
the DX in a low-temperature environment (around 10°C or 
less), use the DX after the warm-up time (at least 30 minutes) 
has elapsed. If you are using the DX under a high-temperature 
environment (around 40°C or more), it is recommended that the 
external storage medium be inserted into the drive when saving 
the data and be removed after the data storage operation is 
finished.

• Remove the storage medium from the drive when starting/
stopping the power supply.

• Touching the compact flash section when static electricity is built 
up on the human body can lead to erroneous operation.

• For the general handling precautions of the external storage 
medium, see the instruction manual that came with the external 
storage medium.

 CAUTION

• Do not eject the storage medium while the memory access 
indicator is illuminated. This can damage the data.

• Do not access the storage medium in a place with vibrations or 
shock. The storage medium or drive may malfunction.

Checking the Contents of the Package
Unpack the box and check the contents before operating the 
instrument. If some of the contents are not correct or missing or 
if there is physical damage, contact the dealer from which you 
purchased them.

 DX
A name plate is located on the side panel of the DX. Check that the 
model name and suffix code given on the name plate match those 
on your order.

Name plate

MODEL

FREQUENCY
NO.

SUFFIX

SUPPLY

STYLE
H S

 NO. (Instrument Number)
When contacting the dealer from which you purchased the 
instrument, please give them the instrument number.
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MODEL and SUFFIX Code
Model Suffix 

Code
Optional 

Code
Notes

DX364 Daqstation DX364 4ch, 125 ms (25 ms)*2

Internal 
memory 

-1 Standard memory (80 MB)

External 
storage 
medium

-4 CF card (with medium)

Language -2 English  deg F and DST
Options /A1 Alarm output 2 points*1

/F1 FAIL/Status output*1

/M1 Mathematical functions (including the 
report function)

/P1 24 VDC/AC power supply
/R1 Remote control
/CC1 Calibration correction function

*1 /A1 and /F1 cannot be specified together.
*2  Scan interval. Values in parentheses are for the fast sampling 

mode.

 Standard Accessories
The standard accessories below are supplied with the instrument. 
Check that all contents are present and undamaged.

1 32

6 7

4

5

32MB

No. Name Part No./ 
Model

Qty. Notes

1 Mounting brackets B8708FA 2 For panel 
mounting

2 Support mounting 
brackets

B8708FH 1 For panel 
mounting

3 Tail hold bracket B8708FN 1 For panel 
mounting

4 Tail hold bracket 
attachment screw

Y9408LH 2 M4

5 DX364 User’s 
Manual

IM 04L70B01-
01E

1 A4 size (this 
manual)

6 License sheet - 1 For 
DAQSTANDARD

7 CF card B8706NQ 1 128 MB (the size 
and model may 
change)

 Optional Accessories (Sold Separately)
The following optional accessories are available for purchase 
separately. If you make an order, make sure that all contents 
are present and undamaged. For information about ordering 
accessories, contact the dealer from which you purchased the DX.
No. Name Model Minimum 

Q’ty
Notes

1 CF card 772093 1 512 MB
772094 1 1 GB
772095 1 2 GB

2 Shunt resistor
(for screw terminal)

415920 1 250 Ω ± 0.1%
415921 1 100 Ω ± 0.1%
415922 1 10 Ω ± 0.1%

3 User’s Manuals 
for the DX1000/
DX1000N/DX2000

B8706ZZ 1 CD. Contains 
the PDF file of 
the DX1000/
DX1000N/
DX2000 user’s 
manual.

Version and Suffix Codes Described in This Manual
• The contents in this manual correspond to DX with version 2.01 

and DAQSTANDARD software revision R8.2x.
• This manual covers information regarding DXs that have a suffix 

code for language “-2” (English).
• For details on how to set the language, see section 2.6, 

“Changing the Language” in the DX1000/DX1000N User’s 
Manual (IM 04L41B01-01E). The selectable languages on the 
DX are English and Japanese.

Conventions Used in This Manual
 Unit

K: Denotes 1024. Example: 768 KB (file size)
k: Denotes 1000.

The following markings are used in this manual.

 

Improper handling or use can lead to injury to the user or damage 
to the instrument. This symbol appears on the instrument to 
indicate that the user must refer to the user’s manual for special 
instructions. The same symbol appears in the corresponding place 
in the user’s manual to identify those instructions. In the manual, 
the symbol is used in conjunction with the word “WARNING” or 
“CAUTION.”
 WARNING

Calls attention to actions or conditions that could cause serious or 
fatal injury to the user, and precautions that can be taken to prevent 
such occurrences.
 CAUTION

Calls attentions to actions or conditions that could cause light 
injury to the user or damage to the instrument or user’s data, and 
precautions that can be taken to prevent such occurrences.
     Note
Calls attention to information that is important for proper operation 
of the instrument.
     
Indicates after this mark reference to related procedure or 
explanation.
  Bold characters
Indicates character strings that appear on the screen and the 
operation keys.
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关于产品污染防止管理 /Control of Pollution Caused by the Product
前言

根据中华人民共和国电子信息产品污染防止管理对本产品进行了说明。

This is an explanation for the product based on “Control of pollution caused by Electronic Information Products” in the People’s Republic of China.

产品中有毒有害物质或元素的名称及含量

部件名称

有毒有害物质或元素

铅

Pb

汞

Hg

镉

Cd

六价铬

Cr(VI)

多溴联苯

PBB

多溴二苯醚

PBDE

LCD 显示器 × × × ○ ○ ○
印刷电路板配件 × × × ○ ○ ○
内部接线的材料 × × × ○ ○ ○
存储媒体驱动 × × × ○ ○ ○

箱体和底座
塑料 × × × ○ ○ ○
金属 × × × ○ ○ ○

电源 × × × ○ ○ ○
操作键 × × × ○ ○ ○

附件 /选配件

端子用螺钉 × × × ○ ○ ○
安装支架 × × × ○ ○ ○
安装辅助支架 × × × ○ ○ ○
固定支架 × × × ○ ○ ○
固定支架用螺钉 × × × ○ ○ ○
CF 卡

772091,772092,

772093,772094,

772095

× × × ○ ○ ○

CF 卡适配器

772090 × × × ○ ○ ○

分流电阻

415920,415921,

415922
× × × ○ ○ ○

○：表示该部件的所有均质材料中的有毒有害物质或元素的含量均低于 GB/T 26572 标准所规定的限量要求。

×：表示该部件中至少有一种均质材料中的有毒有害物质或元素的含量超过 GB/T 26572 标准所规定的限量要求。

本产品的部分部件包含 RoHS 指令中的限用物质，但是其使用方法不受该指令限制。

Some parts of this product include the restricted substances of RoHS Directive, but their applications are under the 
exemption of the directive.

环保使用期限

该标志为环境保护使用期限，根据 SJ/T11364，适用于在中国 ( 台湾、香港、澳门除外 ) 销售的电子电气产品。

只要您遵守该产品相关的安全及使用注意事项，在自制造日起算的年限内，则不会因产品中有害物

质泄漏或突发变异，而造成对环境的污染或对人体及财产产生恶劣影响

注）该年数为“环保使用期限”，并非产品的质量保证期。零件更换的推荐周期，请参照使用说明书
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Waste Electrical and Electronic Equipment (WEEE)
This is an explanation of how to dispose of this product based on Waste Electrical and Electronic Equipment (WEEE), Directive and Regulation.
Only valid in the EEA for EU WEEE Directive and in the UK for UK WEEE Regulation.
• Marking
  This product complies with the WEEE marking requirement. This marking indicates that you must not discard this electrical/electronic product in 

domestic household waste. When disposing of products in the EEA or UK, contact your local Yokogawa office in the EEA or UK respectively.

 

How to Replace and/or Dispose the Batteries
This is an explanation about the EU Battery Directive/Regulation and UK Battery Regulation. Only valid in the EEA for EU Battery Directive/
Regulation and in the UK for UK Batter Regulation.
Batteries are included in this product. You cannot replace batteries by yourself. When you need to replace and/or dispose batteries, contact your 
local Yokogawa office in the EEA or UK respectively.

Battery type: Lithium battery

 

Notice: The symbol (see above) means they shall be sorted out and collected as ordained in the EU Battery Directive/Regulation and UK Battery 
Regulation. 

Supported Standards
This product supports the standards in the following table.

Item Specifications
CSA CAN/CSA-C22.2 No. 61010-1, CAN/CSA-C22.2 No. 61010-2-030, Overvoltage Category II or I*1, Pollution 

Degree 2*2, and Measurement Category II*3

UL UL 61010-1, UL 61010-2-030 (CSA NRTL/C), Overvoltage Category II or I*1, Pollution Degree 2*2, and 
Measurement Category II*3

CE, UKCA
EMC directive EN 61326-1 Class A, Table 2 (For use in industrial locations) compliant

EN 61000-3-2 compliant
EN IEC 61000-3-2 compliant
EN 61000-3-3 compliant
EN 55011 Class A, Group 1 compliant

Low voltage directive EN 61010-1, EN IEC 61010-2-030 compliant, Overvoltage Category II or I*1, Pollution Degree 2*2, and 
Measurement Category II*3

EU RoHS directive EN IEC 63000 compliant
WEEE directive Compliant
EMC regulatory arrangement in Australia and New Zealand (RCM)

EN 55011 Class A, Group 1 compliant
KC marking KS C9811, KS C9610-6-2 compliant
*1 Overvoltage Category: Describes a number which defines a transient overvoltage condition. Iimplies the regulation for impulse 

withstand voltage. Applies to electrical equipment which is supplied from the fixed installation like a distribution board.
II: Applied to standard power supply(100-240V AC)
I: Applied to /P1 option (24V DC/AC)

*2 Pollution Degree 2: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface resistivity is 
adhering. “2” applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.

*3 Measurement Category II: Applies to measuring circuits connected to low voltage installation, and electrical instruments supplied with 
power from fixed equipment such as electric switchboards.
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Introduction to Functions

Measured Items
You can connect DC voltage, thermocouple, and ON/OFF signals and make various 
measurements such as temperature and flow rate. The DX samples the input signals at 
the scan interval to obtain the measured values. The fastest scan interval is 25 ms.
Up to four alarm conditions can be set for each measurement channel.

Data Storage Function
There are two methods of recording measured data. One is to record the measured data 
continuously, and the other is to record only when certain events occur such as alarms. 
The measured data is recorded to the internal memory at a specified interval. The data 
in the internal memory can be stored to an external storage medium automatically or 
manually. By connecting to a network via the Ethernet interface, the measured data can 
also be automatically transferred to an FTP server on a network.

  

DX

Signal input

Ethernet
Automatic data transfer to an FTP server

CF card (auto or manual)

USB flash memory (manual)

FTP server

ENTER
DISP/

Internal
memory

Display Function
You can assign measurement channels to display groups and display the trend, numeric 
value, and bar graph.

  

Trend display Numeric (digital) display Bar graph display

Other Functions
Computation Function (option) Various types of computation can be performed by 

assigning equations to computation channels.
FAIL/status output function (option) Outputs an alarm when the DX fails. The function also 

monitors the DX status such as the remaining amount of 
internal memory and outputs alarms.

Remote control function (option) A specified action is executed when a remote input signal 
is applied to the terminal on the rear panel.

Security function Enables only registered users can operate the DX. The 
function can also be used to prohibit key operation.

Communication function The Ethernet interface can be used to monitor the DX 
using a Web browser and transmit e-mail when an event 
occurs such as an alarm. In addition, data of devices 
on the network can be loaded and displayed using the 
Modbus protocol.
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DAQSTANDARD
The software program, DAQSTANDARD, can be used to display the measured data, 
convert the measured data format, and create DX setup data.

DX System Configuration
The DX can be used to configure a system as shown below.
Referenced sections are of the DX1000/DX1000N User’s Manual.
Referenced pages are of this manual.

Ethernet
(Communication Interface User's Manual)

USB port

Alarm output*
Sections 3.5 to 3.8

PC

DX

DX DX1000Temperature
controller

FAIL/status output*
Section 2.9

Keyboard
   Page 18 and 19

Signal input
Section 3.3

Remote input*
   Section 7.1
   Page 32 and 33

CF card
   Page 14

Keys

USB flash memory
   Page 15

*: Options

ENTER
DISP/

ENTER
DISP/

Terminology
• Memory sample
 The operation of recording measured data.
• Memory start
 The operation of starting the memory sample.
• Memory stop
 The operation of stopping the memory sample.
• Display data
 The waveform data shown on the DX display. The data recorded at the sampling 

interval for the displayed data.
• Event data
 Measured data recorded at a sampling interval separate from that of the display data.

Introduction to Functions
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Operation

Names of Parts
Front View

START USER

ESCSTOP

CF CARDUSB

ENTER
DISP/

Front cover opened

LCD
Display various operation 
displays such as the trend 
display as well as setup displays.

USB port
A USB port conforming to 
Rev. 1.1.

CF card slot

Memory access indicator

CF card eject button
Ejects the CF card.

Front cover
Open the cover by pulling on the 
tab at the top center.

Power indicator
Illuminates in orange when the 
power is turned ON. Illuminates 
in green while memory sample 
is in progress.

Rear Panel

100-240V AC
50/60Hz 35VA MAX

10Base-T

Ethernet port
A 10Base-T port.

Optional terminals (/R1 option)
Connect the remote control input 
signal wires.

Power supply terminal

Signal input terminal
Connect input signal wires from 
the measured item.

Terminal block (with a terminal cover)
Various terminals are arranged.

Protective ground terminal

Optional terminals 
(/A1 or /F1 options)
Connect optional output signal 
wires.
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Workflow
When using the DX for the first time, carry out the following procedure.

 

Installation

Wiring

Environmental Settings

Functional Settings

Measurement

Data Management

Install the DX.
    Page 47 and subsequent pages

Connect input/output wires to the terminals and connectors on the 
rear panel, and connect the power cord.
    Page 51 and subsequent pages

Set the date/time, load the CF card, and so on.
    Page 13 and subsequent pages

Set measurement functions.
    Page 17 and subsequent pages

Start the measurement. Perform operations such as switching the 
screen and writing messages. Save the measured data.
    Page 24 and subsequent pages
    Section 4.1 in the DX1000/DX1000N User's Manual (IM 04L41B01-01E)

Check and manage the measured data.
Use the software program, DAQSTANDARD, to display 
the measured data and convert the measured data to Excel, Lotus 1-2-3, 
and ASCII formats.
    Page 45 and subsequent pages
    DAQSTANDARD Viewer User's manual (IM 04L41B01-63EN)

Basic Operation
Panel Keys

START USER

ESCSTOP

CF CARDUSB

ENTER
DISP/

START USER

ESCSTOP

CF CARDUSB

ENTER
DISP/

START/STOP key
Memory start/stop

ESC key
Cancels an operation

USER key
Executes the assigned 
operation

DISP/ENTER key and four arrow keys 
(up, down, left, and right)
Switches the operation screen. Selects and 
enters setup items.

LCD

Keys

Left arrow key
Up arrow key
DISP/ENTER key
Down arrow key
Right arrow key

Operation
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Changing the Date/Time
In this example, we will change the date from the 1st to the 6th. After carrying out this 
step, reset the time to the correct date/time.

1. Show the operation display.

     

2. Press DISP/ENTER once. The display menu appears.

3. Press the up arrow key or down arrow key to select FUNCTION.

4. Press the right arrow key once to display the sub menu.

5. Press the up arrow key or down arrow key to select DATE & TIME.
* To clear the DATE & TIME item from the display menu, see page 35.

     

Select DATE & TIME

Sub menu

Display menu

6. Press DISP/ENTER once. The Time set window appears.

7. Change the date from 01 to 06.
Select the input position: Press the right arrow key five times. The cursor moves.
Select the value: Press the up arrow key five times. 6 is displayed.

     

Time set window
(When 6 is displayed)

8. Press DISP/ENTER once. The setting is confirmed, and the Time set window 
clears.
Cancel the setting: Press ESC before pressing DISP/ENTER.

Operation complete.

Operation
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Setting or Removing the CF Card
Setting the CF Card

1. Open the front cover.

     

CF card

With the label “This side 
up” facing up

This side up CAUTION

Forcing the CF card into the slot 
with the upside down may cause 
damage.

2. Insert a CF card into the slot.
The message “Media was recognized.” appears.

3. Close the front cover.

Operation complete.

Removing the CF Card
1. Press DISP/ENTER once. The display menu appears.

2. Press the up arrow key or down arrow key to select FUNCTION.

3. Press the right arrow key once to display the sub menu.

4. Press the up arrow key or down arrow key to select MEDIA EJECT CF.

     

MEDIA EJECT CF

5. Press DISP/ENTER once.
The message “Media can be removed safely” appears. The light blue CF card icon appears.

6. Open the front cover.

7. Press the CF card eject button, and remove the CF card.
When you eject the CF card, the light blue CF card icon clears.

     

Eject button

Press the eject button in until it clicks. 
The eject button stops at depressed 
position.

Operation
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8. Close the front cover.

Operation complete.

Note
• The data in the internal memory can be stored on a CF card. The storage operation can also 

be aborted.
1. Select the file to be saved in INFORMATION > MEMORY SUMMARY of the display 

menu, and select INFORMATION > SELECT SAVE or ALL SAVE from the display menu 
to execute the data storage operation.

2. You can abort the data storage operation by selecting FUNCTION > SAVE STOP from 
the display menu.

• If you remove the CF card without carrying out the media eject procedure, the message 
“Media was removed compulsorily” appears. Eject the CF card by carrying out steps 1 to 8 
to prevent damaging the data that is stored.

• When closing the front cover, check that the CF card and the eject button are in the 
depressed position.

Setting or Removing the USB Flash Memory
Setting the USB Flash Memory

1. Open the front cover.

     

USB flash memory

2. Connect a USB flash memory to the USB port.
The window shown in the figure below or the message “USB device is connected.” appears.
If the window in the figure below appears, press the up arrow key or down arrow key to 
select Cancel, and press DISP/ENTER once.

Operation complete.

Loading a Setup File from the USB Flash Memory
1. Open the front cover.

2. Show the operation display.

3. Connect a USB flash memory containing the setup file to the USB port.
A following window appears.

     

Operation
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4. Press the up arrow key or down arrow key to select Load Settings, and press 
DISP/ENTER once.
A list of setup files stored on the USB flash memory appears.
For a description of the selections that appear when you connect a USB flash memory, see 
section 2.12 in the DX1000/DX1000N User’s Manual (IM 04L41B01-01E).

5. Press the up arrow key or down arrow key to select the file you want to load, 
and press DISP/ENTER twice.

Operation complete.

Note
If you connect a USB flash memory to the DX and load a setup file, the settings of the setting 
mode and basic setting mode are loaded.

Removing the USB Flash Memory
1. Press DISP/ENTER once. The display menu appears.

2. Press the up arrow key or down arrow key to select FUNCTION.

3. Press the right arrow key once to display the sub menu.

4. Press the up arrow key or down arrow key to select MEDIA EJECT USB.

     

MEDIA EJECT USB

5. Press DISP/ENTER once.
The message “Media can be removed safely” appears.

6. Remove the USB flash memory.

7. Close the front cover.

Operation complete.

Note
• The data in the internal memory can be stored on a USB flash memory. The storage 

operation can also be aborted.
1. Select the file to be saved in INFORMATION > MEMORY SUMMARY of the display 

menu, and select INFORMATION > SELECT SAVE or ALL SAVE from the display menu 
to execute the data storage operation.

2. You can abort the data storage operation by selecting FUNCTION > SAVE STOP from 
the display menu.

• If you remove the USB flash memory without carrying out the media removal procedure, the 
message “Media was removed compulsorily.” appears. Remove the USB flash memory by 
carrying out steps 1 to 7 to prevent damaging the data that is stored.

Operation
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Setup Procedure
This section describes the operating procedures of the DX. You cannot set the setting 
mode and basic setting mode from the front panel keys of the DX. Use the USB keyboard 
for this task. For an explanation of the settings, see the following manuals. Note that the 
operating procedures of the DX differ from those described in the DX1000/DX1000N/
DX2000 manual. Familiarize yourself with the setup procedures described in this manual 
before reading the manuals.

Contents Manual Title
Operating procedures of the DX 
and the functional explanation and 
setup operations only for the DX

DX364 User’s Manual
(IM 04L70B01-01E)

Frequency used setup procedures DX1000/DX1000N Operation 
Guide (IM 04L41B01-02E)

Detailed functional explanation and 
setup procedures

DX1000/DX1000N User’s 
manual (IM 04L41B01-01E)

Note
The manuals are written with the displays of the setting mode and basic setting mode rotated 
90 degrees counterclockwise.

Run Modes

Power ON

Basic setting mode

Esc key

F12 key

Enter key Enter key Esc key

End menu > Enter key

Setting modeOperation mode

Ctrl+M key
or

Windows key

Esc key,
Ctrl+M key,

or
Windows key

Mode Transition Diagram

Operation display

Setting menu display

Setup display

Basic settings
menu display

Setup display

Operate using the keys on the USB 
keyboard.
“Ctrl+M key” denotes the operation 
of pressing the Ctrl key and the M 
key simultaneously.

The DX has three modes.
Mode Type Description
Operation mode A mode for performing measurements.
Setting mode A mode in which input range, measurement mode, and so on are 

configured. Settings can be changed when memory sample is in 
progress excluding some items.

Basic setting mode A mode used to set basic items such as the scan interval and storage 
format of measured data. You cannot switch to this mode when memory 
sample or computation is in progress.

* For the default values of the setting mode and basic setting mode, see pages 40 to 44.

Operation
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Relationship between the Display Orientation and Key Operation
The display of the setting mode and basic setting mode is shown horizontally and rotated 
90 degrees clockwise as shown below. Operate the DX as follows:

   

← key

→ key

↓ key

↑ key

Operate using the keys on the USB keyboard

Setting the DX Using the USB Keyboard
You cannot set the setting mode and basic setting mode from the front panel keys of the 
DX. Use the USB keyboard for this task.
● Mapping of the Keys on the DX to the Keys on the USB Keyboard

DX364 Key DX1000 Key Key on the USB keyboard Notes
(Keys written in 
the manuals )

104 keyboard for the PC (US)

DISP/ENTER DISP/ENTER Enter, Num Enter
Left arrow Left arrow ← See “Relationship 

between the Display 
Orientation and Key 
Operation” above.

Up arrow Up arrow ↑
Down arrow Down arrow ↓
Right arrow Right arrow →
Arrow Arrow Tab, Shift+Tab*3

START START Ctrl+S*2

STOP STOP Ctrl+P*2

ESC ESC Esc
USER USER Ctrl+U*2

–*1 FUNC F9
–*1 Soft keys F1 to F5*4

–*1 MENU Ctrl+M*2, Windows Setting mode
–*1 Hold down FUNC 

for 3 s
F12 From the setting 

mode to the basic 
setting mode

*1 There is no corresponding key on the DX. Use the USB keyboard.
*2 Press the Ctrl key and the corresponding key simultaneously.
*3 Moves the cursor to the next item (Tab) or the previous item (Shift+Tab) when selectable 

items are displayed. However, they do not work in the following displays.
 Operation display, setup menu display, character or number input display, menu customize 

setup display, and file operation display.
*4 Use the F1 to F5 keys as follows:

• For the key operations of the FUNC key menu, see page 25.
• For the soft keys of the setting mode and basic setting mode, see the figure below.

      

Keys on the USB keyboard

Soft keys

F1

F2

F3

F4

F5

Operation
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Note
• You can connect or disconnect the USB keyboard regardless of the DX status.
• One keyboard can be connected.
• Use a keyboard appropriate for the language setting on the DX.

● Entering Alphabets, Numbers, and Symbols
 Symbols that can be used for units, tags, and messages are as follows:

# % ( ) – ° @ + * . / _ Space

 Use the ^ key to enter the degree symbol.

 However, symbols that can be used in expressions and data save destination 
directory are as follows:
Expression ( ) – + * : [ ] . / ? Space
Data save destination 
directory name* # % ( ) – ° @ + . _ Space

* If you enter °, it becomes ^ in a folder name on the PC.
 The following combinations cannot be entered.
 All spaces, space or period as the first character, and period as the last character

● Invalid Keys
 Keys enclosed in a frame are invalid.

   

104 keyboard for the PC (US)

Operation
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Operation Example in Setting Mode: Setting the Input Range
Set the input range of channel 2 to thermocouple type T and 0.0 to 400.0°C.
The procedure below is given using the keys on the USB keyboard.

  
Type T thermocouple Channel 2

DX

ENTER
DISP/

1. Show the operation mode display.

     

2. Press the Ctrl+M key or the Windows key once. The Setting menu appears.

3. Press the ← key once to select Meas channel.

4. Press the ↓ key once.

     

Select the Range, Alarm

5. Press the Enter key once.

     
Select First-CH
(The selected area is displayed using 
a blue cursor.)

6. Press the F2 key (2) once. The Last-CH is also set to 2.

7. Press the ↓ key or Tab key once. The cursor moves to Mode.

Operation
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8. Press the F3 key (TC) once. The cursor moves to Range. The changed item is 
displayed in yellow.

     

Select TC

9. Press the F5 key (Next).

10. Press the F3 key (T) once. The cursor moves to Span_L.

11. Press the F1 key (Input) once.

     

Display the numeric input window

12. Enter “0.0” in the Span_L box.
Select the digit:  Press the → key once. The cursor in the text box moves.
Enter characters:  Press the Space key three times.
Enter the input:  Press the Enter key once. Span_L is set, and the cursor moves to 

Span_U.
Cancel the setting:  Press the Esc key before pressing the Enter key (entering the input).

13. Enter “400.0” in the Span_U box.
See step 12.

14. Press the Enter key once. The changed items are entered, and the cursor returns 
to First-CH. The changed items change from yellow to white.

     

15. Press the Esc key three times or the Windows key twice. The DX returns to the 
operation mode screen.

Operation complete.

Operation
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Operation Example in the Basic Setting Mode: Changing the Scan Interval
In this example, we will change the scan interval. Here, the scan interval on the DX is 
changed to 250 ms.
The procedure below is given using the keys on the USB keyboard.

  Measures every 250 ms

DX

ENTER
DISP/

1. Show the operation display.

     

2. Press the Ctrl+M key or the Windows key once. The Setting menu appears.

     

3. Press the F12 key once. Display the Setting menu of the basic setting mode.

     

4. Press the ← key once. Select A/D, Memory.

Operation
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5. Press Enter key once.

     

6. Press the ← key once. The cursor moves to Scan interval.

7. Press the F2 key (250ms) once. The cursor moves to A/D integrate. The 
changed item is displayed in yellow.
Cancel the setting: Press the Esc key before pressing the Enter key.

8. Press the Enter key once. The changed items are entered, and the cursor returns 
to Scan mode.

     

Set the scan interval to 250 ms

9. Press Esc once to return to the basic setting mode menu.

10. Press the → arrow key twice to move the cursor to End.

11. Press Enter key once.

     
Display the confirmation window

12. Press Enter key (Yes) once. The settings are saved, and the DX returns to the 
operation mode screen.
Discard the changes: Select No and press the Enter key.
Do not end the basic setting mode: Select Cancel and press the Enter key.

Operation complete.

Note
To store the setup data to an external storage medium, see section 6.9 in the DX1000/
DX1000N User’s Manual (IM 04L41B01-01E).

Operation
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Operation
Starting or Stopping the Memory Sample

● Starting the Memory Sample
1. Press the START key once.

Memory sample starts.

     
START USER

ESCSTOP

CF CARDUSB

ENTER
DISP/

Power indicator
Green: Memory sampling in progress
Orange: Memory sampling stopped

START key

STOP key

Operation complete.

● Stopping the Memory Sample
1. Press the STOP key once.

2. Use the up or down arrow keys to select Mem+Math.
Mem+Math: Stops memory sample and computation (/M1 option).
If the model does not have the computation function (/M1 option), a confirmation message “Do 
you want to stop data storage?” appears. Select Yes.

3. Press DISP/ENTER once.

Operation complete.

Status Icons That Appear on the Display
The following icons appear in the measurement data display section.

  

CF card icon

Alarm icon

Heart Beat icon

Status icon

(Red)

(Red)

(Light blue)

(Green)

Switches at a constant 
interval when the DX is 
operating normally.

The status assigned to the status output relay (/F1 option) 
is occurring.

Displayed when any alarm is activated.
Blinks when there are alarms that are occurring but have 
not been acknowledged.*

All alarms have been released after they have occurred, 
but there are alarms that have not been acknowledged.*

A CF card is inserted in the slot but is not detected. 
Eject the CF card and set the CF card again to detect it.

Icon display section Heart Beat icon

CF card error.

Displayed when the remaining amount of space on the 
CF card is less than or equal to 10%.

* Activated when configured to use alarm ACK.
 For details on how to set the alarm ACK function, see 

section 1.2 in the DX1000/DX1000N User’s Manual (IM 
04L41B01-01E).

(Red)(Dark blue) (Light blue)

Operation



25IM 04L70B01-01E

Operating the Display Menu and FUNC Key Menu
● Display Menu

1. Press DISP/ENTER once. The display menu appears.

2. Press the up or down arrow key to select the item you want to display.

3. Press the right arrow key once to display the sub menu.

4. Press the up or down arrow key to select the item you want to display.

     Sub menu

Display menu

5. Press DISP/ENTER once to display the selected item.
To close the menu without switching the display, press ESC.

Operation complete.

● FUNC Key Menu
 You can acknowledge alarms, write messages, and carry out operations related to 

computation and timer while the DX operation is in progress.
 You need a USB keyboard to use the FUNC key menu. The procedure below is given 

using the keys on the USB keyboard.
 For details on FUNC key menu, see section 4.1 in the DX1000/DX1000N User’s 

Manual (IM 04L41B01-01E).

1. Press the F9 key once to display the FUNC key menu.

2. Press any of the F1 to F3 keys once to execute the corresponding action.
 Press the F4 key once to switch the menu corresponding to the F1 to F3 keys to 

the next item.
To close the menu without executing the action, press the F9 key or the Esc key.

     

FUNC key menu

Keys on the USB keyboardF1 F2 F3 F4

Operation complete.

Note
You can select whether to display the menu items in the display menu and FUNC key menu 
using the menu customize function. See section 5.17 in the DX1000/DX1000N User’s Manual (IM 
04L41B01-01E).

Operation
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Switching among Trend Display, Digital Display, and Bar Graph Display
● Switching the Display Using the Display Menu

1. Press DISP/ENTER once to show the display menu.

2. Press the down arrow key to select TREND, DIGITAL, or BAR.

3. Press the right arrow key once to display the sub menu. To close the sub menu 
that you opened, press the left arrow key.

4. Press the down arrow key to select the group.

     
Select DIGITAL > GROUP 1

5. Press DISP/ENTER once to show the operation display of the selected group.

     
Digital display

Operation complete.

● Switching the Display Using the Arrow Keys
 Press the up or down arrow key to switch the display type. Press the left or right 

arrow key to switch the display group.

   

GROUP 1 GROUP 2 GROUP 10

Right arrow 
key

Up
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Left arrow 
key

Right arrow key Right arrow key

Left arrow key Left arrow key

Operation
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Available Displays
The following displays can be shown.

 

Trend (bar graph) Historical trend (bar graph)Trend (current value mark)

Digital Alarm summaryBar graph

Message summary Modbus client

Log

Memory summary

Relay status display Report display

The following types of logs are available.
• Login • E-mail Transmission
• Error • SNTP
• Communication • DHCP
• FTP transfer • MODBUS
• WEB

Operation
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DX364 Functions and the Default Values of Setup Items

Comparison Table of DX364 and DX1004 Functions and Specifications

Description Details DX364 DX1004
Structure External dimensions 72 (W) x 144 (H) x 406 (D) mm (projections 

excluded). D: Depth from the panel surface
144 (W) x 144 (H) x 223 (D). D: Depth from 
the panel surface

Weight Approx. 2.9 kg (excluding the mounting 
bracket set)

Approx. 2.9 kg (excluding options and 
mounting brackets)

Dust-proof, water-proof structure 
of the front panel

None Complies with IEC529-IP65 and NEMA 4 
(water-proof)

Functional ground terminal None Available
Door lock function None Available
Structure allowing the inner 
instrument to be pulled out from 
the front panel

Available DX1004: None, DX1004N: Available

Power 
supply

Maximum power consumption 26 VA (100 VAC), 35 VA (240 VAC) 45 VA (100 VAC), 60 VA (240 VAC)
Power consumption under 
normal operation

16 VA (100 VAC), 23 VA (240 VAC) 24 VA (100 VAC), 32 VA (240 VAC)

Power consumption when the 
LCD backlight is off

14 VA (100 VAC), 20 VA (240 VAC) 15 VA (100 VAC), 25 VA (240 VAC)

Keys Keys on the DX START key, STOP key, DISP/ENTER key, 
up, down, left, and right arrow keys, USER 
key, and ESC key

START key, STOP key, DISP/ENTER key, up, 
down, left, and right arrow keys, USER key, 
ESC key, Favorite key, MENU key, FUNC 
key, and soft keys.

STOP key operation Select Mem+Math or Cancel for the STOP 
operation on models with the /M1 option.

Select Mem+Math, Mem, or Cancel for the 
STOP operation on models with the /M1 
option.

Storage Internal memory size 80 MB 80 MB (standard memory) or 200 MB 
(expanded memory)

Functions Batch function None Available
Log display function Available See pages 30 to 

39 in the DX364 
User’s Manual (this 
manual).

None
Simulation function Available None
Clearing the internal memory/
displayed waveform

Available None

Turn ON/OFF the time display Available None
Number of channel display digits 
of the current value mark

Available None

Turn ON/OFF the DATE & TIME 
display on the display menu

Available None

Display alarm ranges using color 
band

Available None

External 
media

USB flash memory Settings of the basic setting mode and setting 
mode are loaded by default when loading the 
data at the time the memory is connected.

Settings of the setting mode are loaded by 
default when loading the data at the time the 
memory is connected.

Media removal Operate from the display menu or FUNC key 
menu

Operate using the FUNC key

Abort all data save Operate from the display menu or FUNC key 
menu

Operate using the FUNC key

Input section Number of inputs and scan 
interval

4 inputs, 125/250 ms (high-speed mode: 25 
ms)

4 inputs, 125/250 ms (high-speed mode: 25 
ms)

Input type DC voltage, TC, and DI DC voltage, TC, RTD, and DI
Input computation Log, delta computation (DC voltage, TC, and 

DI), scaling (DC voltage, TC, or DI), square 
root computation, and 1-5V

Delta computation (DC voltage, TC, RTC, 
and DI), scaling (DC voltage, TC, RTC, or 
DI), square root computation, and 1-5V

Display Display 3.5-inch color TFT LCD 5.5-inch color TFT LCD
240 (horizontal) × 320 (vertical) dots 320 (horizontal) × 240 (vertical) dots

Language English or Japanese English, Japanese, German, French, or 
Chinese

Status display section None
Displays the following icons at the top section 
of the display.
Alarm, media unmount, media error, and 
status relay

Available
Displays the group, date/time, user name, 
memory sample status, and various icons.

Display group 4 channels/group maximum 6 channels/group maximum
Scale display position 1 to 4 1 to 6
String entry Does not display a keypad

(Unable to enter from the DX keys. Enter 
using a USB keyboard.)

Displays a keypad
(Enter from the DX keys or a USB keyboard 
(USB port: /USB1 option))

Description Details DX364 DX1004
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Description Details DX364 DX1004
Display Trend display

Display type Wide Horizontal, vertical, wide, or split
Historical trend display

Display type Half screen display not available Half screen display available
Display value Current minimum and maximum display Total minimum and maximum display as well 

as current minimum and maximum display
Digital display

Time display Available Shown in the status display section
Bar graph display

Display direction Vertical Horizontal or Vertical
Base position Lower Normal, center, lower, or upper

Overview display None Available
Information display

MODBUS client Displayed horizontally and rotated clockwise 
by 90 degrees

Horizontal display

Log display Displayed horizontally and rotated clockwise 
by 90 degrees

Horizontal display

Setup display Displayed horizontally and rotated clockwise 
by 90 degrees

Horizontal display

FUNC key menu 4 items maximum. 5 items maximum.
Display menu Items below in addition to the DX1004 display 

menu
Media removal function, save abort function, 
and time setting function

–

Power On screen Displayed horizontally and rotated clockwise 
by 90 degrees

Horizontal display

System information screen ROM part number added to version –
Network information screen Ethernet link indicator added to the upper 

right of the display.
–

Favorite display function None Available
WEB server WEB display Displayed in 240 (horizontal) × 320 (vertical) 

dot resolution
Displayed in 320 (horizontal) × 240 (vertical) 
dot resolution

Favorite key None Available
Other displays Bar graph and digital Bar graph, digital, and overview

Options Alarm output relay 2 outputs (/A1) 2 outputs (/A1), 4 outputs (/A2), 6 outputs 
(/A3)

Remote control (/R1) 4 inputs 8 inputs
Items below in addition to the DX1004 control
Memory clear and start/stop screen update

–

USB Interface Standard: 1 port on the front panel Option (/USB1): 1 port each on the front and 
rear panels

Switches for computation (/M1) D01-D04 (/R1 option), I01-I02 (/A1 option), 
S01-S30 (internal switch), and F1-F8 (flag)
However, D05-D08, I03-I06, P01-P08, and 
Q01-08 can be specified in the expression, 
but the value is fixed to zero.

D01-D08 (/R1 option), I01-I06 (/A□ option), 
S01-S30 (internal switch), F1-F8 (flag), 
P01-P08 (/PM1 option: pulse scan interval), 
and Q01-Q08 (/PM1 option: pulse 1-second 
interval)

24-VDC/AC power supply power 
consumption (/P1)

24 VDC: 13 VA (maximum), 8 VA (normal 
operation), 6 VA (with the LCD 
backlight turned off)

24 VDC: 28 VA (maximum), 15 VA (normal 
operation), 8 VA (with the LCD 
backlight turned off)

24 VAC (50/60 Hz): 25 VA (maximum), 15 VA 
(normal operation), 14 VA (with the 
LCD backlight turned off)

24 VAC (50/60 Hz): 45 VA (maximum), 24 VA 
(normal operation), 15 VA (with the 
LCD backlight turned off)

Options that can only be 
installed only to the DX1000 and 
not the DX364

Serial interface (/C2 and /C3), clamp input terminal (/H2), desktop type (/H5□), special RTD 
input (/N1, /N2, and /N3), 24-VDC transmitter power supply (/TPS2 and /TPS4), easy text 
entry (/KB1 and /KB2), and pulse input (/PM1)

Standard 
software

DAQSTANDARD
(software for configuration and 
data display)

DXA120/S2 See pages 45 and 
46 in the DX364 
User’s Manual (this 
manual).

DXA120

Features and Specifications of the DX1004 with Release Numbers 3 and 4
The DX364 does not have the new features that have been added to the DX1004 in 
release numbers 3 and 4. Pages iv and v in the DX1000/DX1000N User’s Manual 
contains a list of features that have been added to the DX1004 in release numbers 3 and 4. 
The new features are also indicated with “release number 3 or later” or  “release number 
4 or later” in the functional and procedural explanations in the user’s manuals. 
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Log Display Function
Setting the Log Display

● Function
 Measures the DC voltage and displays the data using a Log scale (common 

logarithm). The following computation is carried out, and the result is displayed.
 Input voltage: X Lower limit of display span: VL
 Upper limit of display span: VU Lower limit of scaling: SL
 Upper limit of scaling: SU Displayed value: Y
 Then, We obtain
 Y = 10(SU – SL)×(X – VL)/(VU – VL) + SL

● Setup Display
 Press Ctrl+M key or Windows key (switch to the setting mode), and select Meas 

channel > Range, Alarm

   

● Setting
 Set the following items to the log display channel.

 Mode (Log), range (20 mV to 50 V), span lower limit, span upper limit, lower limit of 
the exponent of the scale, upper limit of the exponent of the scale, and unit

Note
• You can set the exponent of the scale in the range from 1.0E-15 to 1.0E+15.
• Set the lower and upper limits of the exponent of the scale so that the upper limit is greater 

than the lower limit.
• The maximum exponential difference between the lower and upper limits of the scale is 15.
• Set the alarm type to H, L, T, or t.
• The alarm hysteresis is fixed to 0%.
• Set the alarm value using a voltage value.
• The following functions cannot be used on a channel set to Log display.

• Expression (/M1 option): The computed result is error.
• Report channel (/M1 option): The result is error.
• Partial expanded display: Cannot be specified.
• Delta computation: The computed result is error.
• Calibration correction (/CC1 option): Cannot be specified.

● Communication Command
 SR Sets the input range
 Sets the Log display

Syntax  SR p1,p2,p3,p4,p5,p6,p7,p8,p9<terminator>
  p1 Measurement channel number (DX364: 001 to 004)
  p2 Input type (LOG)
  p3 Measurement range (20MV, 60MV, 200MV, 2V, 6V, 20V, or 50V)
  p4 Span lower limit
  p5 Span upper limit
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  p6 Lower limit of the exponent of the scale (-15 to 15)
  p7 Upper limit of the exponent of the scale (-15 to 15)
  p8 Decimal position (fixed to 0)
  p9 Unit (up to 6 characters)
Query  SR[ p1]?

Example   Set channel 002 to Log display. Set the measurement range to 6 V, the 
span to –6 V to 6 V, the lower limit of exponent to –5, the upper limit of 
exponent to 6, the decimal position to 0, and the unit to abc.

  SR002,LOG,6V,-6000,6000,-5,6,0,abc

Description Parameter p7 must be greater than p6.
  Make sure p7 – p6 does not exceed 15.
   For other descriptions, see the DX1000/DX1000N/DX2000 

Communication Interface User’s Manual (IM 04L41B01-17E).

Note
The communication output/binary data output value of the Log display channel is an A/D 
normalized value.*

* A scaled value taking the full span value of the range to be 20000.

Setting the Number of Digits of the Mantissa of the Log Scale Display
● Function
 Sets the number of displayed digits of the scale mantissa when Log display is 

specified to 2 or 3.

● Setup Display
 Press Ctrl+M key or Windows key (switch to the setting mode), press F12 key (switch 

to the basic setting mode) , and select Environment > Digits, Time indicate

● Setting
 Sets the number of displayed digits of the mantissa to 2 or 3.

● Communication Command
 QA  Sets the Number of Digits of the Mantissa of the Log Scale 

Display
Syntax  QA p1<terminator>
  p1 Number of displayed digits of the mantissa (2, 3)
   2 Displays the mantissa in 2 digits
   3 Displays the mantissa in 3 digits
Query  QA?

Example  Set the number of displayed digits of the mantissa to two.
  QA2
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Simulation Function
● Function
 Stops or starts the screen updating using event action or communication command.

• For details on event action function, see chapter 7 in the DX1000/DX1000N User’s Manual 
(IM 04L41B01-01E).

 The event action Display Freeze/Active operates as a level action.
• Stops the screen updating if a open-to-close event (rising edge of the remote 

signal) is detected.
• Returns to normal operation if a close-to-open event (falling edge of the remote 

signal) is detected.

    

Open

Close

Screen update
stopped

Normal operation 2

Normal
operation 2

Normal operation 1

Normal 
operation 1

• Screen image of the operation

• Remote control signal

Time

When the updating of the display is resumed, the current waveform is 
displayed from the stopped position.

● Setup Display
 Press Ctrl+M key or Windows key (switch to the setting mode), and select Timer, 

Event action > Event action

   

● Setting
 Event: Select Remote.
 Remote number: Set the terminal number of the remote control function (/R1 option).
 Action: Select Freeze.
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● Communication Command
 QB  Sets the simulation function or clears the internal memory and 

trend waveform
Syntax  QB p1<terminator>
  p1 Action
   0 Resume the updating of the screen.
   1 Stop the updating of the screen.
   2 Clear the internal memory and the trend.
Example  Stop the updating of the screen.
  QB1

Other Functions
Clearing the Internal Memory/Displayed Waveform

● Function
 Clears the internal memory and displayed waveform using event action or 

communication command. The data from the last automatic data storage until the 
reception of the signal is not saved to the CF card.

• For details on event action function, see chapter 7 in the DX1000/DX1000N User’s Manual 
(IM 04L41B01-01E).

● Setup Display
 See the setup display (previous page) of the simulation function.

● Setting
 Event: Select Remote.
 Remote number: Set the terminal number of the remote control function (/R1 option).
 Action: Select MemClear.

● Communication Command
 See the QB command of the simulation function.

Turning ON/OFF the Time Display
● Function
 Shows/hides the time on the display.

● Setup Display
 Press Ctrl+M key or Windows key (switch to the setting mode), press F12 key (switch 

to the basic setting mode), and select Environment > Digits, Time indicate

● Setting
 Turns ON/OFF the time display.

● Communication Command
 QC Sets the time display

Syntax  QC p1<terminator>
  p1 Show/hide the time display (ON or OFF)
   ON  Show the time
   OFF Hide the time
Query  QC?

Example  Hide the time.
  QCOFF
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Number of Channel Display Digits of the Current Value Mark (Applied Only to 
Computation Channels)

● Function
 Sets the number of channel display digits of the current value mark.

Channel Type Channel Display of the Current Value Mark
3 digits 2 digits

Computation channel (/M1 option)
101 to 112 1 to 12 

● Setup Display
 Press Ctrl+M key or Windows key (switch to the setting mode), press F12 key (switch 

to the basic setting mode), and select Environment > AUX

   

Turn ON/OFF the time setting (see “Turning ON/OFF the 
Time Setting” on the next page)

Number of channel display digits of the current value mark

● Setting
 Set 1 as follows:

 On: Sets the number of channel display digits to 2.
 Off: Sets the number of channel display digits to 3.

● Communication Command
 WUAUX  Sets the number of channel display digits of the current value 

mark, turns ON/OFF the time setting, or displays alarm ranges 
usinf color bands

Syntax  WUAUX p1,p2,p3,p4<terminator>
  p1  Number of channel display digits of the current value mark (ON or 

OFF)
   ON  Display using two digits
   OFF Display using three digits
  p2 Show/hide the time setting on the display menu (ON or OFF)
   ON  Show the time setting
   OFF Hide the time setting.
  p3 Alarm point mark display or color band display (ON or OFF)
   ON  Display alarm ranges using color bands.
   OFF Display alarm point marks.
  p4 No function
Query  WUAUX?

Example   Set the number of channel display digits of the current value mark to 2, 
hide the time setting, and display alarm ranges usein color bands.

  WUAUXON,OFF,ON,ON
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Turning ON/OFF the Time Setting
● Function
 Shows/hides the DATE & TIME item on the display menu.

● Setup Display
 Set the following items as follows on the setup display of the “Number of Channel 

Display Digits of the Current Value Mark” (previous page).

● Setting
 Set 2 as follows:

 On: Show the time setting
 Off: Hide the time setting.

● Communication Command
 See the WUAUX command in “Number of Channel Display Digits of the Current Value 

Mark.”
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Color Band Display (This function was added on January 2009)
● Function
 Alarm ranges, which indicate the ranges in which alarms will occur, are displayed 

using color bands on the scale. If you combine this function with the color scale band, 
which displays a specified section of the measurement range using color bands on 
the scale, you can display the whole scale using different color bands. See the display 
example on the next page.

● Setup Screen and Setup Items
 Displaying Alarm Ranges Using Color Bands
 Press the Ctrl+M key or Windows key (switch to the setting mode), press the F12 

key (switch to the basic setting mode), and select Environment > AUX

   

 Set 3 under AUX to On. This setting is common to all channels.
Settings Description
On Displays alarm ranges using color bands in the specified colors.
Off Displays alarm point marks using the specified colors. For details, see section 

5.8 in the DX1000/DX1000N User's Manual (IM04L41B01-01E).

 Setting the Colors of the Color Bands
 Press the Ctrl+M key or Windows key (switch to the setting mode), and select Meas 

channel > Alarm mark

   

 Specify colors for the color bands of each channel. Set Mark kind to Fixed, Indicate 
on Scale to On, and then specify colors for Alarm 1 to Alarm 4 under Alarm mark 
color.
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 Mark kind
Settings Description
Fixed Displays alarm ranges using color bands.
Alarm Displays alarm point marks. For details, see section 5.8 in the DX1000/

DX1000N User's Manual (IM04L41B01-01E).

 Alarm mark color > Alarm 1 to Alarm 4
Settings Description
24 colors The band colors for alarm 1 to alarm 4 of the specified channel.

 Color bands are displayed as follows:
● Color bands are only displayed when the high limit alarm, low limit alarm, delay 

high limit alarm, delay low limit alarm, difference high limit alarm, or difference low 
limit alarm is set.

● Using the specified colors, color bands indicate alarm ranges. For example, 
consider a channel with measurement range of 0.00 to 100.00. If you set the high 
limit alarm to 50.00, the color band is displayed for the range from 50.00 to 100.00.

 As another example, consider the case in which you set a high limit alarm on alarm 
2 at 50.00 and a high limit alarm on alarm 1 at 80.00. A color band using the color 
assigned to alarm 2 is displayed for the range from 50.00 to 80.00, and a color 
band using the color assigned to alarm 1 is displayed for the range from 80.00 to 
100.00.

● Setup and Display Examples (Using the Color Scale Band at the Same  
 Time)
 Set the alarms and the color scale band on channel 1 as shown in the figure below. 

For details on the color scale band settings, see section 5.8 in the DX1000/DX1000N 
User's Manual (IM04L41B01-01E).

   

Channel 1　Measurement span: from 0.00 to 100.00
100.00

0.00

20.00 Low limit alarm (alarm 1)

45.00 Low limit alarm (alarm 2)

65.00 High limit alarm (alarm 3)

85.00 High limit alarm (alarm 4)

Color scale band
45.00～65.00
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Alarm Setup Example Color Band Setup Example Color Scale Band Setup Example

Color band for alarm 4 
(Orange)

Color band for alarm 3 
(Yellow)

Color scale band 
(Lime)

Color band for alarm 2 
(Yellow)

Color band for alarm 1 
(Orange)

The current value can be displayed 
as a mark or a bar graph. 
For details, see section 5.7 in the
DX1000/DX1000N User’s Manual 
(IM04L41B01-01E). 

Display Example Displaying Color Bands
(When 3 under AUX on the Environment page 
is set to Off)

Display Example Displaying Alarm Point Marks 
(When 3 under AUX on the Environment page 
is set to On)

● Communication Command
 Use the WUAUX command to set whether or not to use color bands to display alarm 

ranges. For details on the WUAUX command, see page 34.
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Larger Scale Font
The scale values are now displayed larger than with previous versions of the DX364.

  

Changes to the Scales on the Bar Graph Display
The scales on the bar graph display show not only main scale marks, but also medium 
scale marks, small scale marks, and scale values. The number of scale divisions is 
common between the scales on the bar graph and trend displays. For details, see section 
5.7 in the DX1000/DX1000N User's Manual (IM04L41B01-01E).
 ● Regardless of the settings, the number of digits displayed for the scale values is 

always set to Fine. For details, see section 5.7 in the DX1000/DX1000N User's 
Manual (IM04L41B01-01E).

 ● The scale values are the same size as on the trend display's scale.
 ● Units are not displayed on the scales.
 ● The scale values on the channels set to Log display are displayed such as "E+01."
 ● The same color bands or alarm point marks as those on the trend display appear 

on the scale. With the bar graph display, however, regardless of whether Indicate on 
Scale is On or Off (see "Setting the Colors of the Color Bands" for details), the color 
bands or the alarm point marks are displayed.

Display Example Displaying Color Bands Displaying Alarm Point Marks
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Default Values of Setup Items
 Default Values of Setting Mode

Date/Time > Date & Time
Setup Item Default Value
Time set −

Date/Time > Daylight saving time
Setup Item Default Value
Use/Not Not

Meas channel > Range, Alarm
Setup Item Default Value
First-CH, Last-CH 1
Mode Volt
Range 2V
Span_L −2.0000
Span_R 2.0000
Alarm > 1 Off
Alarm > 2 Off
Alarm > 3 Off
Alarm > 4 Off

Meas channel > Tag, Memory, Delay
Setup Item Default Value
First-CH, Last-CH 1
Tag > Characters −
Memory sample > On/Off On
Alarm delay > Time 10 (s)

Meas channel > Moving average
Setup Item Default Value
First-CH, Last-CH 1
Moving average > On/Off Off

Meas channel > Color
Setup Item Default Value
Color > 001 Red
Color > 002 Green
Color > 003 Blue
Color > 004 B.violet

Meas channel > Zone, Scale
Setup Item Default Value
First-CH, Last-CH 1
Zone > Lower 0 (%)
Zone > Upper 100 (%)
Scale > Position 1
Scale > Division 10

Meas channel > Partial
Setup Item Default Value
First-CH, Last-CH 1
Partial > On/Off Off

Meas channel > Alarm mark
Setup Item Default Value
First-CH, Last-CH 1
Alarm Mark > Mark kind Alarm
Alarm Mark > Indicate on Scale Off

Meas channel > Color scale band
Setup Item Default Value
First-CH, Last-CH 1
Color scale band > Band area Off

Meas channel > Calibration correction (option /CC1)
Setup Item Default Value
First-CH, Last-CH 1
Number of set points Off

Math channel > Expression, Alarm (option /M1)
Setup Item Default Value
First-CH, Last-CH 101
Math Off

Math channel > Constant (option /M1)
Setup Item Default Value
Number of constant K01
Value 1

Math channel > Tag, Memory, Delay (option /M1)
Setup Item Default Value
First-CH, Last-CH 101
Tag > Characters −
Memory sample > On/Off On
Alarm delay > Time 10 (s)

Math channel > TLOG, Rolling average (option /M1)
Setup Item Default Value
First-CH, Last-CH 101
TLOG > Timer No. 1
TLOG > Sum scale Off
TLOG > Reset Off
Rolling average > On/Off Off

Math channel > Color (option /M1)
Setup Item Default Value
Color > 101 Red
Color > 102 Green
Color > 103 Blue
Color > 104 B.violet
Color > 105 Brown
Color > 106 Orange
Color > 107 Y.green
Color > 108 Lightblue
Color > 109 Violet
Color > 110 Gray
Color > 111 Lime
Color > 112 Cyan

Math channel > Zone, Scale (option /M1)
Setup Item Default Value
First-CH, Last-CH 101
Zone > Lower 0 (%)
Zone > Upper 100 (%)
Scale > Position 1
Scale > Division 10

Math channel > Partial (option /M1)
Setup Item Default Value
First-CH, Last-CH 101
Partial > On/Off Off

Math channel > Alarm mark (option /M1)
Setup Item Default Value
First-CH, Last-CH 101
Alarm Mark > Mark kind Alarm
Alarm Mark > Indicate on Scale Off
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Math channel > Color scale band (option /M1)
Setup Item Default Value
First-CH, Last-CH 101
Color scale band > Band area Off

Math channel > Math start action (option /M1)
Setup Item Default Value
Math start Start

Display > Trend/Save interval
Setup Item Default Value
Trend interval (/div) 1min
Save interval 1h
Second interval (/div) 1min

Display > Trend
Setup Item Default Value
Direction Wide
Trend clear Off
Message direction Horizontal
Scale > Digit Normal
Scale > Value indicator Bargraph
Trend line 2 (dot)
Grid Auto (div)

Display > LCD
Setup Item Default Value
Brightness 4
Backlight saver > Mode Off

Display > Monitor
Setup Item Default Value
Background > Display White
Background > Historical trend Black
Scroll time 10s
Jump default display Off

Group set, Trip line
Setup Item Default Value
Group number 1
Group set > On/Off On (1 to 4 group), Off (5 to 

10 group)
Group set > Group name GROUP 1, etc.
Group set > CH set 001.002.003.004
Trip line > 1 Off
Trip line > 2 Off
Trip line > 3 Off
Trip line > 4 Off

Message
Setup Item Default Value
Message No. > 1 −
 to −
Message No. > 100 −

Timer, Event action > Timer
Setup Item Default Value
Timer No. 1
Mode Off

Timer, Event action > Match time timer
Setup Item Default Value
Timer number 1
Kind Off

Timer, Event action > Event action
Setup Item Default Value
Logic box number 1
Event None

Data save > File header, File name
Setup Item Default Value
File header > Characters −
Data file name > Structure Date
Data file name > Identified strings −

Data save > Save directory
Setup Item Default Value
Directory name DATA0

Data save > Event data
Setup Item Default Value
Sample rate 1s
Mode Free
Data length 1h

Save/Load
Setup Item Default Value
Load display data −
Load event data −
Load settings −
Save settings −
File list/delete −
Format > Volume name −

Menu customize
Setup Item Default Value
Function menu Hide: None
Display menu Hide:

 TREND > TREND 
SPACE

 INFORMATION >
  MODBUS CLIENT, 

RELAY, M.SAMPLE 
SAVE, REPORT SAVE

 LOG
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Setup Items in Basic Setting Mode and Their Default Values

Alarm > Basic settings
Setup Item Default Value
Reflash Off
Rate of change > Decrease 1
Rate of change > Increase 1
Indicator Nonhold

Alarm > Switch, Relay
Setup Item Default Value
Internal Switch > AND None
Relay > AND None
Relay > Action Energize
Relay > Hold Nonhold
Relay > Relay Action on ACK Normal

Alarm > Hysteresis
Setup Item Default Value
Meas CH > High/Low 0.5 (%)
Meas CH > Delta High/Low 0.0 (%)
Math CH > High/Low 0.0 (%)

A/D, Memory
Setup Item Default Value
Scan interval > Scan mode Normal
Scan interval > Scan interval 125ms
Scan interval > A/D integrate Auto
Memory > Data kind Display

Burnout, RJC
Setup Item Default Value
First-CH, Last-CH 1
Burnout set Off
RJC > Mode Internal

Environment > Operating environment
Setup Item Default Value
Tag/Channel Tag
Language English
Remote Controller ID Off (fixed)
Temperature C

Environment > View, Message
Setup Item Default Value
View > Trend type T-Y (fixed)
View > Partial Off
View > Trend rate switching Off
Message > Write group Common
Message > Power-fail message Off
Message > Change message Off

Environment > Input, Alarm
Setup Item Default Value
Input > Value on over-range Over
Alarm > No logging Off

Environment > Security, Media save
Setup Item Default Value
Security > Key Off
Security > Communication Off
Save > Auto save On
Save > Media FIFO Off

Environment > Batch
Setup Item Default Value
On/Off Off (fixed)

Environment > Service port
Setup Item Default Value
FTP 21
HTTP 80
SNTP 123
Modbus 502

Environment > Math (option /M1)
Setup Item Default Value
Value on Error +Over
Value on Overflow > SUM, AVE Skip
Value on Overflow > MAX, MIN, P-P Over

Environment > Report (option /M1)
Setup Item Default Value
Report select > 1 Ave
Report select > 2 Max
Report select > 3 Min
Report select > 4 Sum
File type Separate

Environment > Digits, Time indicate
Setup Item Default Value
Display digits > Digits 2
Time indicate > On/Off On

Environment > AUX
Setup Item Default Value
1 (Number of channel display digits of 

the current value mark)
Off

2 (ON/OFF of DATE & TIME on the 
display menu)

On

3 (Selection alarn point mark display 
or alarm range color band dispaly)

Off

4 (No function) Off

Keylock > Password, Key action, Media
Setup Item Default Value
Password −
Key action > START Free
Key action > STOP Free
Key action > MENU* Free
Key action > USER Free
Key action > DISP/ENTER Free
External media Free
*  For the USB keyboard operation.

Keylock > Action of Function
Setup Item Default Value
AlarmACK Free
Message/Batch Free
Math Free
Data save Free
E-mail/FTP Free
Time set Free
Display Function Free

Login > Basic settings
Setup Item Default Value
Auto logout Off
Operation without Login Off
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Login > Admin settings
Setup Item Default Value
Admin number 1
Mode Off

Login > User settings
Setup Item Default Value
User number 1
Mode Off

Login > Authority of user > Key action, Media
Setup Item Default Value
Authority of user 1
Key action > START Free
Key action > STOP Free
Key action > MENU* Free
Key action > USER Free
Key action > DISP/ENTER Free
External media Free
*  For the USB keyboard operation.

Login > Authority of user > Action of Function
Setup Item Default Value
Authority of user 1
AlarmACK Free
Message/Batch Free
Math Free
Data save Free
E-mail/FTP Free
Time set Free
Display Function Free

Report > Basic settings
Setup Item Default Value
Report kind Off

Report > Report settings
Setup Item Default Value
Report channel number R01
Report channel number > On/Off On (R01 to R04), Off (R05 

to R12)
Report channel number > Channel Varies depending on the 

report channel number
Report channel number > Sum scale /s

Time settings
Setup Item Default Value
Time zone (HHMM) 900
Time deviation limit 30s
Date format Y/M/D

Load settings, Initialize
Setup Item Default Value
Load settings −
Initialize > Kind Clear 3
Media eject −

Communication (Ethernet) > IP-address
Setup Item Default Value
DHCP Not
Fixed IP-address > IP-address 0.0.0.0
Fixed IP-address > Subnet mask 0.0.0.0
Fixed IP-address > Default gateway 0.0.0.0

Communication (Ethernet) > Host settings
Setup Item Default Value
Host name −
Domain name −

Communication (Ethernet) > DNS settings
Setup Item Default Value
Server search order > Primary 0.0.0.0
Server search order > Secondary 0.0.0.0
Domain suffix search order > Primary −
Domain suffix search order > 
Secondary

−

Communication (Ethernet) > Keep alive, Timeout
Setup Item Default Value
Keep alive On
Application time out > On/Off Off

Communication (Ethernet) > Server
Setup Item Default Value
FTP Not
Web Use
SNTP Not
Modbus Not

Communication (Ethernet) > Web page
Setup Item Default Value
Page type Operator
Page type > On/Off Off

Communication (Ethernet) > E-Mail > Basic settings
Setup Item Default Value
SMTP server name −
Port number 25
Recipient 1 −
Recipient 2 −
Sender −

Communication (Ethernet) > E-Mail > Alarm settings
Setup Item Default Value
Recipient 1 Off
Recipient 2 Off
Active Alarms > Alarm 1 Off
Active Alarms > Alarm 2 Off
Active Alarms > Alarm 3 Off
Active Alarms > Alarm 4 Off
Include INST Off
Include source URL Off
Subject Alarm_summary
Header 1 −
Header 2 −

Communication (Ethernet) > E-Mail > Scheduled 
settings
Setup Item Default Value
Recipient 1 Off
Interval 24h
Ref.time 00:00
Recipient 2 Off
Interval 24h
Ref.time 00:00
Include INST Off
Include source URL Off
Subject Periodic_data
Header 1 −
Header 2 −



44 IM 04L70B01-01E

DX364 Functions and the Default Values of Setup Items

Communication (Ethernet) > E-Mail > System settings
Setup Item Default Value
Recipient 1 Off
Recipient 2 Off
Include source URL Off
Subject System_warning
Header 1 −
Header 2 −

Communication (Ethernet) > E-mail > Report settings
Setup Item Default Value
Recipient 1 Off
Recipient 2 Off
Include source URL Off
Subject Report_data
Header 1 −
Header 2 −

Communication (Ethernet) > FTP client > FTP transfer 
file
Setup Item Default Value
Disp&Event data Off
Report Off
Snapshot Off

Communication (Ethernet) > FTP client > FTP 
connection
Setup Item Default Value
FTP connection Primary
Server name −
Port number 21
Login name −
Password −
Account −
PASV mode Off
Initial path −

Communication (Ethernet) > SNTP client
Setup Item Default Value
Use/Not Not

Communication (Ethernet) > Modbus client > Basic 
settings
Setup Item Default Value
Read cycle 1s
Retry interval 2min

Communication (Ethernet) > Modbus client > Modbus 
server settings
Setup Item Default Value
Server number 1-8
Port 502
Modbus server name −
Unit Auto

Communication (Ethernet) > Modbus client > 
Command settings
Setup Item Default Value
Client command number 1-8
1 Off
 to Off
16 Off

Status relay (option /F1)
Setup Item Default Value
Memory/Media status Off
Measurement error Off
Communication error Off
Memory stop Off

End
Setup Item Default Value
Do you want to store and make the 
new settings take effect?

−
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This section describes the software program, DAQSTANDARD. For an explanation of the 
settings, see the following manuals.
Contents Manual Title
Differences between the DXA120/
S2 and DXA120

DX364 User’s Manual
(IM 04L70B01-01E)

Functional explanation and setup 
operations of the DXA120

DAQSTANDARD Hardware Configurator 
User’s Manual (IM 04L41B01-64EN)

* The DAQSTANDARD software is DXA120/S2.

Differences between the DXA120/S2 and DXA120
These procedures are carried out using the Hardware Configurator. For a functional 
explanation, see pages 30 to 39 in this manual.

System Configuration Dialog Box

  

DX364 is selectable

Setting the Log Display
Carry out the procedure on the Measure channel tab screen.

  LOG is selectable when the mode is VOLT

Enter the exponent of the 
scale when LOG is selected
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Setting the Simulation Function and Clearing the Internal Memory and 
Displayed Waveform
Carry out the procedure on the General setting tab screen.

  

To use the simulation function
Select Display Freeeze/Active
(selectable when the Event is Remote)

To use the internal memory/display waveform 
clear function Select MemoryClear
(selectable when the Event is Remote)

Setting the Number of Digits of the Log Scale Mantissa Display and 
Turning ON/OFF the Time Display
Carry out the procedure on the Basic setting tab screen.

  

Set the number of digits of the log scale 
mantissa display

Turn ON/OFF the time display.

Setting the Number of Channel Display Digits of the Current Value Mark, 
Turning ON/OFF the Time Setting, or Selecting Alarm Point Mark Display 
or Color Band Display
Carry out the procedure on the Basic setting tab screen.

  

Number of channel display digits of the 
current value mark

Alarm point mark display or color band 
display

Turn ON/OFF the time setting

Setup File Export Function
Outputs the setup data to an Excel file or a tab-separated text file. This function is useful 
for printing the setting for comparison and confirmation.
Procedure

1. On File menu the Hardware Configurator Window, choose Export > Excel... or 
Text....

2. Specify the save destination and file name and click the Save button.

Operation complete.
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Installation Location
Install the DX indoors in a location that meets the following conditions.
• Instrumentation Panel
 The DX is designed to be installed in an instrumentation panel.
• Well-Ventilated Location
 Install the DX in a well-ventilated location to prevent the temperature inside the 

instrument from rising. For the panel cut dimensions when arranging multiple DXs, 
see the page 50. Follow the panel cut dimensions providing adequate space between 
instruments when other instruments are arranged on the panel.

• Minimum Mechanical Vibrations
 Choose an installation location with the minimum mechanical vibration. Installing the 

DX in a location with large mechanical vibration not only causes adverse effects on 
the mechanism but also may hinder normal recording.

• Horizontal
 Install the DX horizontally (However, the DX can be inclined up to 30 degrees 

backwards for panel mounting).
• Ambient temperature range between 0 to 50°C
•  Ambient humidity between 20 to 80%RH, However, less than moisture 

content of 40°C 80% RH at 40°C or more, No condensation should be 
present.

• Altitude 2000 m or less

Note
 Condensation may occur if the DX is moved to another place where the ambient 

temperature is higher, or if the temperature changes rapidly. In addition, measurement 
errors will result when using thermocouples. If this happens, let the DX adjust to the new 
environment for at least one hour before using it.

Do not install the DX in the following places.
• Outdoors
• In Direct Sunlight or Near Heat Sources
 Install the DX in a place with small temperature fluctuations near room temperature 

(23°C). Placing the DX in direct sunlight or near heat appliances can cause adverse 
effects on the internal circuitry.

•  Where an Excessive Amount of Soot, Steam, Moisture, Dust, or 
Corrosive Gases Are Present

 Soot, steam, moisture, dust, and corrosive gases will adversely affect the DX. Avoid 
such locations.

• Near Strong Magnetic Field Sources
 Do not bring magnets or instruments that produce electromagnetic fields close to the 

DX. Operating the DX in strong magnetic fields can cause errors in the measurements.
• Where the Viewing of the Display Is Poor
 The DX uses a TFT color LCD for the display. Therefore, viewing of the display from 

an extreme angle is difficult. Install the DX so that the user can view the display from 
the front.
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Installation Procedure
Use a steel panel of thickness 2 mm to 26 mm.

1. Remove the seals covering the holes for the mounting brackets on the top and 
bottom of the case.

     

Seals

2. Insert the DX from the front of the panel.

3. Pass the support mounting brackets provided from the rear panel through the 
case all the way up to the panel.

4. Mount the DX on the panel using the mounting brackets provided.
• Use a mounting bracket on the top and bottom of the case.
• For mounting, use the insertion section of the support mounting bracket and the holes for 

the mounting brackets.
• Attach the mounting bracket for the bottom of the case by lifting the rear section of the 

case up from the support supplied by the user.
• The proper torque for tightening the mounting bracket screws is 0.7 to 0.9 N-m.

    

Holes for the
mounting brackets

Insertion section

Support mounting 
brackets

Mounting 
bracketssupport supplied 

by the user

 CAUTION
• Be sure to securely insert the mounting bracket in the insertion section of the 

support mounting bracket.
• Tightening the screws too much can deform the case or damage the bracket.
• Be careful not to insert foreign objects or tools through the holes for the 

mounting brackets in the case.
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 Mounting Bracket Installation Diagram

     

Support mounting
brackets

Mounting brackets

Mounting brackets

Torque driver

 Single-Unit Mounting

5. Fix the rear section of the case to the support supplied by the user using the tail 
hold bracket provided. The proper torque for tightening the screw is 1.4 to 1.5 
N-m.
Drill and tap holes for the M4 screws in the support supplied by the user at the positions 
indicated in the figure below in advance.

     

Tail hold bracket

385

79.4
Tail hold bracket

attachment screw (2-M4)

 Side-by-Side Mounting

5. Prepare a tail hold bracket with sufficient strength.

6. Fix the rear section of the case to the support supplied by the user using the tail 
hold bracket. As necessary, insert cushioning material between each case so that 
the rear section of the case does not wobble.

     

Tail hold bracket
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External Dimensions and Panel Cut Dimensions

DISP/
ENTER

Rear View

Unit: mm
(approx. inch)

Unless otherwise speci f ied,  to lerance is ±3%
(however,  to lerance is ±0.3 mm when below 10 mm).

Recommended positions of the
support supplied by the user

Side-by-Side MountingSingle-Unit Mounting

(72 x Units Quantity – 4)

Panel Cut Dimensions

Tail Hold Bracket Dimensions (Standard Accessory)
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Input Signal Wiring

 WARNING
•  To prevent electric shock while wiring, ensure that the power supply source is 

turned OFF.

 CAUTION
•  If a strong tension is applied to the cable wired to the DX, the terminals of the DX 

and/or the cable can be damaged. In order to prevent tension from being applied 
directly on the terminals, fasten all wiring cables to the rear of the mounting panel.

• To prevent fire, use signal wires having a temperature rating of 70°C or more.
•  Do not apply a voltage exceeding the following value to the input terminals. 

Otherwise, damage to the DX may result.
 • Maximum input voltage: ±60 VDC
 •  Maximum common mode voltage: ±60 VDC (under measurement category II 

conditions)

Precautions to Be Taken While Wiring
Take the following precautions when wring the input signal cables.
It is recommended that crimp-on lug with insulation sleeves (designed for 
4-mm screws) be used when connecting the input/output signal wires to 
the terminals.

   Crimp-on lug with insulation sleeves (for 4 mm screws) 

Separate the conductive section of the measurement circuit wire and the DX case (metal 
section) by at least 3 mm.
Take measures to prevent noise from entering the measurement circuit.
• Move the measurement circuit away from the power cable (power circuit) and ground circuit.
• It is desirable that the object being measured does not generate noise. However, if 

this is unavoidable, isolate the measurement circuit from the object. Also, ground the 
object being measured.

• Shielded wires should be used to minimize noise caused by electrostatic induction. 
Connect the shield to the ground terminal of the DX as necessary (make sure you are 
not grounding at two points).

• To minimize noise caused by electromagnetic induction, twist the measurement circuit 
wires at short, equal intervals.

• Make sure to earth ground the protective ground terminal through minimum resistance 
(less than 100 Ω).

Do not allow static electricity to be applied to the terminals.
• When wiring the terminals, remove static electricity so that static electricity is not applied.
• If static electricity or similar high-voltage transient noise is applied to the signal line, 

the system may break.
When using internal reference junction compensation on the thermocouple 
input, take measures to stabilize the temperature at the input terminal.
• Always use the terminal cover.
• Do not use thick wires which may cause large heat dissipation (cross sectional area of 

0.5 mm2 or less recommended).
• Make sure that the ambient temperature remains reasonably stable. Large 

temperature fluctuations can occur if a nearby fan turns ON or OFF.
Connecting the input wires in parallel with other devices can cause signal 
degradation, affecting all connected devices. If you need to make a parallel 
connection, then
• Turn the burnout detection function OFF.
• Ground the instruments to the same point.
• Do not turn ON or OFF another instrument during operation. This can have adverse 

effects on the other instruments.
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Wiring Procedure
Input terminals are arranged on the rear panel.

1. Remove the terminal cover.
Remove the terminal cover slowly and gently from the top or bottom edge. Applying a strong 
force or shock can cause the cover to break or crack.

2. Connect the signal wires to the terminals. The proper torque for tightening the 
screws is 1.4 to 1.5 N-m.

3. Attach the terminal cover.

Arrangement of the Input Terminals

  

100-240V AC
50/60Hz 35VA MAX

10Base-T

Input terminals

CH1+
–

CH3+
–

CH2 +
–

CH4 +
–

  

TC inputDC voltage input/DI (ON/OFF) input

DC current input

–

+ +

–
DC voltage input

–

+

Compensating leadwire

DC current input

Shunt resistor
Example: For 4 to 20 mA input, use a 
 shunt resistor of 250 Ω ± 0.1%

–

+

–

+
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Optional Terminal Wiring

 WARNING
• To prevent electric shock while wiring, ensure that the power supply source is 

turned OFF.
• If a voltage of more than 30 VAC or 60 VDC is to be applied to the output 

terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals 
to prevent the wires from slipping out when the screws become loose. 
Furthermore, use double-insulated wires (dielectric strength of 3000 VAC or 
more) for the signal wires on which a voltage of more than 30 VAC or 60 VDC is 
to be applied. For all other wires, use basic insulated wires (dielectric strength of 
1500 VAC). To prevent electric shock, attach the terminal cover after wiring and 
make sure not to touch the terminals.

 CAUTION
• Use the following circuit voltage for the connection to the alarm/FAIL/status 

output terminal.
• When the connection is to the main power circuits (primary AC power source 

circuits): 150 V or less
• When the connection is to circuits derived from the main power circuits 

(secondary circuits): 250 V or less
 (The main power circuit voltage is less than 300 V, and connection must be 

used by isolation transformer.)
• To prevent fire, use signal wires having a temperature rating of 70°C or more.
• If a strong tension is applied to the cable wired to the DX, the terminals of the 

DX and/or the cable can be damaged. In order to prevent tension from being 
applied directly on the terminals, fasten all wiring cables to the rear of the 
mounting panel.

Note
For remote control wiring, use shielded wires to reduce noise. Connect the shield to the ground 
terminal of the DX.

Precautions to Be Taken While Wiring
It is recommended that crimp-on lug with insulation sleeves (designed 
for 4-mm screws) be used when connecting wires to the optional input 
terminals.

  Crimp-on lug with insulation sleeves (for 4 mm screws) 

Separate the conductive section of the signal wire and the DX case (metal section) by at 
least 3 mm.

Wiring Procedure
Optional terminals are arranged on the rear panel (see the next page).

1. Remove the terminal cover.
Remove the terminal cover slowly and gently from the top or bottom edge. Applying a strong 
force or shock can cause the cover to break or crack.

2. Connect the signal wires to the terminals. The proper torque for tightening the 
screws is 1.4 to 1.5 N-m.

3. Attach the terminal cover.
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Arrangement of the Optional Terminals

  

100-240V AC
50/60Hz 35VA MAX

10Base-T

NC

C

NO

NC

C

NO

+

-

+

-
3

1

FA
IL

M
EM

O
RY

 (S
TA

TU
S)

100-240V AC
50/60Hz 35VA MAX

10Base-T

Option terminals

NC
1 C
2 NO
3
4
C

NC
C

NO

Remote control 
input 02

Alarm
output

01
NC
C

NO
NC
C

NO

FAIL output

Status output

/R1 /A1 /F1

Alarm Output Terminal (/A1) and FAIL Output Terminal/Status Output Terminal 
(/F1)

 C 
NC 

NO 

Output format: Relay contact 
Contact rating: 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistor load) 
Withstand voltage: 1600 VAC at 50/60 Hz for one minute  
 (between output terminals and the ground terminal) 

Remote Control Input Terminal (/R1)

  

C
1 to 4

• Transistor input (open collector)

Internal circuit

• Relay contact input 
 (voltage-free contact)

Withstand voltage: 1000 VDC for one minute between 
 input terminals and the ground terminal

Input format:
 Photocoupler isolation
 Shared common (C)
Allowable input voltage: 
5 VDC

5 V

Contact closed at 200 Ω or less
Contact open at 100 kΩ or greater

ON voltage: 0.5 V or less (30 mADC)
Leakage current when turned OFF:
 0.25 mA or less

1
2
3
4
C

1
2
3
4
C

Connecting to the USB Port
The USB port complies with Rev. 1.1.

  

START USER

ESCSTOP

CF CARDUSB

ENTER
DISP/

USB port

Precautions to Be Taken When Connecting the Cable
If you are using the DX in an environment in which noise may enter from the power line, 
attach parts that reduce or eliminate noise such as a ferrite core to the USB keyboard 
cable. Noise can cause errors in operation.
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Connecting to the Ethernet Port

  

100-240V AC
50/60Hz 35VA MAX

10Base-T Indicator

Ethernet port

Precautions to Be Taken When Connecting the Cable
If you are using the DX in an environment in which noise may enter from the power line, 
take the measures described below. Noise can cause errors in operation.
• Attach parts that reduce or eliminate noise such as a ferrite core to the power line, 

Ethernet cable, etc.
• Wire the power line as far from the Ethernet cable as possible. Do not bundle the 

power line and the Ethernet cable.

Checking the Connection/Communication Status
You can check the connection status of the Ethernet interface with the indicator that is 
located below the Ethernet connector of the DX on the right.

Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.
  

Checking the Connection on the DX Display
•  Checking the Connection at the status indication section of the DX 

display.
 You can check the connection status of the Ethernet interface with the Ethernet Link 

indicator at the upper right of the network information screen.
 To display the network information screen, press the F9 key on the USB keyboard and 

use the FUNC key menu.
•  Checking the Connection Status in the Display Section in the Upper 

Right Corner of the COMMUNICATION LOG Display of the DX
 You can check the connection status of the Ethernet interface on the Link indicator on 

the display section at the lower right of the COMMUNICATION LOG display.
Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.
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Power Supply Wiring
Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. To prevent electric 
shock and damage to the DX, observe the following warnings.

 WARNING
• To prevent electric shock when wiring, ensure the main power supply is turned 

OFF.
• To prevent the possibility of fire, use 600 V PVC insulated wire (AWG20-16) or 

an equivalent wire for power wiring.
• Make sure to earth ground the protective earth terminal through a grounding 

resistance less than 100 Ω before turning ON the power.
• Use crimp-on lug with insulation sleeves (for 4-mm screws) for power supply 

wires and protective grounding wires.
• Separate the conductive section of the power supply wire from the DX case (metal 

section) by at least 3 mm.
• To prevent electric shock, be sure to attach the terminal cover.
• For safety, provide a double-pole switch in an easily operable location near the 

DX to disconnect the DX from the main power supply. Put an indication on this 
switch as the breaker on the power supply line for the DX and indications of ON 
and OFF. Switch specifications  

 Steady-state current rating: 1 A or more (other than /P1), 3 A or more (/P1). 
 Inrush current rating: 60 A or more (other than /P1), 70 A or more (/P1). 
 Use a switch complies with IEC60947-1, 3.
• Connect a fuse (between 2 A and 15 A) to the power line. Use a fuse approved 

by CSA (for the use in North America) or VDE (for the use in Europe).
• Do not add a switch or fuse to the ground line.

 CAUTION
• If you are using the DX in an environment in which noise may enter from the 

power line, take the measures described below. Noise can cause errors in 
operation.
• Attach parts that reduce or eliminate noise such as a ferrite core to the power 

line, USB keyboard cable, Ethernet cable, etc.
• Wire the power line as far from the Ethernet cable as possible. Do not bundle 

the power line and the Ethernet cable.
• Before supplying power, check that the power cord and power line are connected 

correctly to the DX and that the DX is connected to the correct power supply (see 
the table on the next page).

• If the input wires are connected in parallel with other devices, do not start or stop 
the power supply of the DX or another device during operation. This can have 
adverse effects on the measured values.

• Turn ON the power switch, let the DX warm up for at least 30 minutes, and then 
start the measurements.

• Check that the memory is not being accessed before stopping the power supply.



57IM 04L70B01-01E

Installation and Wiring

Use a power supply that meets the following conditions:
Item Other than /P1 /P1
Rated supply voltage 100 to 240 VAC 24 VDC/AC
Allowable power supply voltage range 90 to 132/180 to 264 VAC 21.6V to 26.4 VDC/AC
Rated power supply frequency 50/60 Hz 50/60 Hz (for AC)
Allowable power supply frequency range 50/60 Hz ± 2% 50/60 Hz±2% (for AC)
Maximum power consumption 26 VA (100 V)/35 VA (240 V) 13 VA (for DC), 25VA (for AC)

Note
Do not use a supply voltage in the range 132 to 180 VAC, as this may have adverse effects on 
the measurement accuracy.

Wiring Procedure
1. Turn OFF the power to the DX, and remove the terminal cover.

Remove the terminal cover slowly and gently from the top or bottom edge. Applying a strong 
force or shock can cause the cover to break or crack.

2. Wire the power cord and the protective ground cord to the power supply terminals. 
Use ring-tongue crimp-on lugs (designed for 4 mm screws). The proper torque for 
tightening the screws is 1.4 to 1.5 N-m.

     

100-240V AC
50/60Hz 35VA MAX

10Base-T

Power supply terminal
Protective ground terminal

Power cord
AC DC Protective ground cord

L
N

+
–

3. Attach the terminal cover.
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Recommended Replacement Periods for Worn Parts
To preserve the reliability of the DX and to use the DX in a good condition for an 
extended time, it is recommended that periodic replacements be made on parts. The 
replacement parts may change to accommodate preventive maintenance over extended 
time. Be sure to check with your nearest YOKOGAWA dealer.
The following table shows the recommended replacement period for expendable parts. 
The replacement period shown here applies when the DX is used under standard 
operating conditions. For the actual replacement period, consider the actual conditions 
of use. Replacement of parts will be carried out by a YOKOGAWA engineer or an 
engineer certified by YOKOGAWA. Contact your nearest YOKOGAWA dealer when such 
replacement is necessary.

  
Item Replacement 

Period
Name Part No. Quantity 

Used
Notes

LCD 2 years (for 
style H: 1)
5 years (for 
style H: 2 or 
over)

DX364 LCD ASSY DX36490 1 Replacement 
parts for the LCD, 
backlight, and front 
panel keys.

Battery 10 years* BATTERY ASSY B8802ZK 1
Aluminum 
electrolytic 
capacitor

10 years* POWER 
ASSY

AC power 
supply

B8708GA 1

24 V power 
supply

B8708GB 1 /P1 option

10 years* AD & MAIN PBA B8708RB 1

* Replacement period at the upper limit of the normal operating temperature (50°C)
 The replacement period varies depending on the operating temperature and the specifications 

of the DX. If the operating temperature is 30°C, you can expect a service life longer than 20 
years.

Note
• The LCD replacement period indicates the half life of the brightness when the brightness 

is set to the factory default setting. The half life is shortened as the brightness is set 
higher. The deterioration of brightness varies depending on the condition of use, and its 
determination is subjective. Consider these facts for determining the actual replacement 
period.

• The color of the LCD may become yellowish as time elapses. The discoloration tends to 
progress faster as the brightness is set higher.

The LCD (part number: DX36490) was changed to the style “H:2”.
The style “H:2” or over products have the increased brightness and the wider adjustment 
ranges.

Pulling Out the Inner Instrument
The inner instrument of the DX can be pulled out.
Because some areas inside the DX have high voltages, be sure to pull out the inner 
instrument correctly. For the procedure, see the Daqstation DX364 Service Manual (SM 
04L70B01-01E).
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